DNP

DIGITAL PHOTO PRINTER

DP-QW410

Version 1.0.1.2

Printer Driver Instruction Manual

Supported OS: Windows 7 and 10

©2019-2023 Dai Nippon Printing Co., Ltd. 2023041702



e Safety precautions
Before you use the printer, carefully read the User Guide to ensure that you use the printer
correctly. Be aware that the content complies with the standards at the time the User Guide
section related to safety, including usage and safety precautions, was created.

e Modifications
To ensure product safety, modification of the DP-QW410 printer and DP-QW410 printer driver is
prohibited.

e Copyright
The copyrights, trademark rights, and other intellectual property rights related to documents and
programs included with this product are the property of Dai Nippon Printing Co., Ltd. and other
rights holders. You cannot copy and use these items without the permission of Dai Nippon
Printing Co., Ltd. except where permitted by applicable laws.

Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the
United States and in other countries.
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Chapter 1 Installation

Installation procedure

The installation procedure is made up of three steps.
The details of each step are explained below.

[ Step 1 Prepare the printer and computer — “1.1 Prepare the printer and computer” ]

At this point, the USB cable is not
yet connected.

[ Step 2 Install the driver package — “1.2 Install the driver package” ]
Q ﬁ Install the driver package.
[ Step 3 Install the printer driver — “1.3 Install the printer driver” ]

USB cable

Connect the USB cable, switch on the printer, and
then install the printer driver.
After installation is complete, restart the computer.
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1.1 Prepare the printer and computer

Make sure that the printer power is off.

Prepare a USB cable. However, do not use the USB cable to connect the printer and computer at
this time.

Log in to Windows as an administrator. The following explanation presumes that the operations are
carried out with administrator privileges.

CAUTION:
The display settings of the computer must be set as follows. If the settings differ from the
following, the printing preferences screen and other items may not fit in the display area.

- Resolution: At least 1280x800
- Size of text and other items (DPI): 100%

1.2 Install the driver package

Open Windows Explorer, and then click the corresponding drive.

Select the following installation folder.
Driver package folder¥DP-QW410_Driver

B E B - | oP-QW410_Driver

File Home Share View 0
- v 4 < Driver » DP-QW410_Driver v O Search DP-QWA10_Driver el
~

Name Date medified Type Size

Doc File folder

DriverPackage File folder
Drriverlnstall. CMD Windows Comma... 1KB
|:] ReadMe_Install_English.txt Text Document TKB
|:] ReadMe_Install_lapanesetd Text Document TKE
5 items =

Figure 1.2.1 Driver Package folder
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In the selected folder, double click the following file: Driverinstal. CMD. (Depending on your usage
environment, the .CMD extension may not be displayed.)

The driver package installer appropriate for your operating system (32-bit or 64-bit) is selected
automatically.

B B B - | 0P-QW410 Driver

File Home Share View 0
— v <« Driver » DP-OW410_Driver v @ Search DP-QW410_Driver yel
Name a Date medified Type Size

Doc 3/27/2019 7:08 PM File folder

DriverPackage 4/19/2019 5:47 PM File folder
riverlnstall.CMD /1472016 11:31 AM - Windows Comma.. TKE
. ReadMe_lnstall_English.txt 4 ) 7 Text Document 1KB

D ReadMe_Install_Japanesetxt Text Document TKE

3 items =

Figure 1.2.2 Installation file

When you start the installer, a window appears for selecting the language that will be used during the
installation. After you select the language to use, click “OK”.

Dai Nippen Printing DP-QW410 - Install5hield Wizard

Select the language for the installation from the choices below.

English (United States) -
Coca

Figure 1.2.3 Language selection screen

Click “Next >” when the Installation Wizard screen appears.

i'{.:— Dai Nippon Printing DP-QWA410 - InstallShield Wizard
Welcome to the InstallShield Wizard for Dai
Nippon Printing DP-QW410

The InstallShield(R) Wizard will install Dai Mippon Printing
DP-QW410 on your computer. To continue, dick Mext.

WARNING: This program is protected by copyright law and
international treaties.

< Back Cancel
Figure 1.2.4 Installation Wizard start screen
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Click “Install” when the installation is ready.

i'&:— Dai Nippon Printing DP-QW410 - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard,

InstallShield

< Back Cancel
Figure 1.2.5 Installation start confirmation screen

When the installation starts, a screen appears that shows the installation status.

i'&:— Dai Mippon Printing DP-QW410 - InstallShield Wizard

Installing Dai Nippon Printing DP-QW410
The program features you selected are being installed.

Please wait while the InstallShield Wizard installs Dai Mippon Printing
DP-QW410. This may take several minutes.

Status:

InstallShield

Figure 1.2.6 Installation status screen
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When a User Account Control dialog box appears, click “Yes”.

User Account Control x

Do you want to allow this app from an
unknown publisher to make changes to your
device?

el T I el
BB B 1010 O ol s
1 "4Dai Nippon Printing DP-QW410.msi

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
[ Yes ] No |

Figure 1.2.7 User Account Control

Click “Install” when the Windows Security confirmation display appears.

B Windows Security

Would you like to install this device software?

Mame: DP-QWA10
,§?, Publisher: Dai Mippon Printing Co., Ltd,

Always trust software from "Dai Nippon Printing Don't Install
Co., Ltd."

You should only install driver software from publishers you trust. How can | decide which device
Yy ¥
software is safe to install?

Figure 1.2.8 Windows Security confirmation
Installation of the driver package starts. Wait until installation finishes.
Click “Finish” when the Installation Wizard completion screen appears.

i'{.:— Dai Mippon Printing DP-QW410 - InstallShield Wizard

InstallShield Wizard Completed

The InstallShield Wizard has successfully installed Dai Mippon
Printing DP-QW410. Click Finish to exit the wizard.

oo Cam) oo

Figure 1.2.9 Finish of Installation Wizard
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1.3 Install the printer driver

Use the USB cable to connect the printer and computer, and then switch on the power of the DP-
QW410 printer.  After the printer is recognized, installation of the driver starts.
*For information on the connection, refer to the User Guide of the printer.

In Windows 7, if driver installation starts, the following message appears in the taskbar: “Installing
device driver software”.
In Windows 10, this message does not appear. Proceed to page 8.

Click here for status,

[ :U Installing device driver software ® *

Figure 1.3.1 Driver installation message

If you click on this message, the “Driver Software Installation” screen appears and displays the
installation status of the driver. If “Close” is clicked, this screen closes.

__ Driver Software Installation @
Installing device driver software
Photo Printer C Searching Windows Update...

Obtaining device driver software from Windows Update might take a while.
Skip obtaining driver software from Windows Update

Figure 1.3.2 Installing the driver software

*About the “Skip obtaining driver software from Windows Update” option

If your operating system is configured to obtain driver software from Windows Update, it may take time
for installation to complete because the process searches for drivers from Windows Update first. You
can reduce the time until the completion of installation by choosing to skip obtaining driver software
from Windows Update. (Depending on your operating system, it may take some time until installation
is complete.)

From the “Driver Software Installation” dialog box, click “Skip obtaining driver software from Windows
Update”.

L Driver Software Installation =
Installing device driver software
Phote Printer {7 Searching Windows Update...

ight take a while.

Skip obtaining driver software from Windows Update

Figure 1.3.3 Option to skip obtaining driver software from Windows Update
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A confirmation dialog box appears. Click “Yes”.

Driver Software Installation @

i Do you want to skip getting driver
— software from Windows Update?

Windows Update provides the latest available driver
software which may work better for your device. You
can check Windows Update later for the latest driver
software. If you skip your device may not function at
all.

Figure 1.3.4 Confirmation to skip getting driver software from Windows Update

After the installation is complete, the message “Your device is ready to use” is displayed in a pop-up
on the taskbar.

“ML vour device is ready to use X
¥ Device driver software installed successfully.

Figure 1.3.5 Installation complete message

If you click on the message, the “Driver Software Installation” dialog appears, and the “Your device is
ready to use” message appears. Click “Close”.

(If the “Driver Software Installation” screen is open when installation starts, the abovementioned
taskbar message is not displayed.)

_'} Driver Software Installation @
Your device is ready to use

USE Printing Support +f Ready to use
DP-QW410 +f Ready to use

Close

Figure 1.3.6 Completion of driver software installation
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Click “Start”, and then click “Windows System” -> “Control Panel” to open the Control Panel.
In Windows 7, click “Start”, and then click “Control Panel” to open the Control Panel.
In Control Panel, click “View devices and printers”.

EE Control Panel — (m]
« v s Control Panel > « & | Search Control Panel ry
Eile Edit View Tools
Adjust your computer's settings Viewby:  Category
System and Security User Accounts
Review your computer's status !;Changeacccuntt}-pa

Save backup copies of your files with
File History
Backup and Restore (Windows 7)

& R

Network and Internet
View network status and tasks

%

—
, / Hardware and Sound

{!%
e

Appearance and
Personalization

Clock and Region

Change date, time, or number formats

Ease of Access

%‘ View devices and printers

Add a device

C

Let Windows suggest settings
Adjust commonly used mobility Optimize visual display

settings

Programs
Uninstall a program
Get programs

8]

Figure 1.3.7 Control Panel

In Devices and Printers, make sure that “DP-QW410” is present.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the DP-QW410
icon is not displayed.

This completes installation of the printer driver.

h Devices and Printers

<« v 4 ¥s « Hardware and Sound * Devices and Printers w & | Search Devices and Printers 0
Eile Edit View Tools
Add a device Add a printer See what's printing Print server properties Remove device = - 0
~
DP-QW410 Fax

DP-QW410  Model: DP-QWA1D
Category: Printer
Status: 0 document(s) in queue

275

Figure 1.3.8 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.
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In Windows 7, when the DP-QW410 printer driver could not be installed correctly, the following
message appears in the taskbar: “Device driver software was not successfully installed”.

‘[0 Device driver software was not successfully installed * *
“¥ Click here for details.

Figure 1.3.9 Message indicating that the driver was not installed

If you click on this message, the “Driver Software Installation” screen appears and displays the
message “Device driver software was not successfully installed”. Click “Close”.

(If the “Driver Software Installation” screen is open when installation starts, the abovementioned
taskbar message is not displayed.)

When the driver could not be installed correctly, see the next section, “1.4 Install drivers for
unspecified

devices”, and then install the printer driver.

_'_l Driver Software Installation @
Device driver software was not successfully installed

USE Printing Support »j Ready to use
Dai Mippon Printing DP-QW410 xNo driver found

What can I do if my device did not install properly?

Close

Figure 1.3.10 When the driver was not installed correctly
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1.4 Install drivers for unspecified devices

If you connect a printer that is on to the computer before installing the driver package, a device is
created under “Unspecified” in “Devices and Printers”.

A Devices and Printers

« “ 4 s <« Hardware and Sound » Devices and Printers v Search Devices and Printers ye)
File Edit View Tools
Add a device Add a printer Remove device = - o

L

Photo Printer

Photo Printer  Model: Photo Printer
L Category:  Unknown

Figure 1.4.1 Photo Printer under Unspecified

In such a case, use the following method to install the printer driver.

Furthermore, use the following method to install the printer driver if you use the standard installation
procedure (install the driver package, connect the printer, and then install the printer driver), but the
driver is not installed correctly, and a device is created under “Unspecified”.

1. Install the driver package
When the driver package has not yet been installed, install it by following the procedure in “1.2
Install the driver package”.
If you install the driver package, installation of the printer driver for the unspecified device completes
it automatically.

2. Installing a driver for an unspecified device
After installing the driver package, the driver installation procedure for an “Unspecified” device is
different for Windows 7 and Windows 10.
For Windows 10, refer to page 11.
For Windows 7, refer to page 12.

10
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In Windows 10:
1. Right-click “Photo Printer” of the “Unspecified” device in “Devices and Printers”, and click
“Remove device” from the pull-down menu.

h Devices and Printers

<« “ A+ [Fa « Hardware and Sound » Devices and Printers w @ Search Devices and Printers 2

File Edit View Tools
Add a device Add a printer Remove device = - o

Create shortcut

I %) Remove device I
Troubleshoot

Photo Printer

Properties

Photo Printer  Model: Photo Printer
L Category:  Unknown

Figure 1.4.2 Delete “Photo Printer”

2. Disconnect the USB cable connected to the printer.
3. Restart your computer.
4. After starting up the computer, connect the USB cable again and turn on the printer.

In Devices and Printers, make sure that “DP-QW410” is present.

Note: When the printer is offline (the printer is not on and connected), the DP-QW410 icon is not
displayed.

This completes installation of the printer driver.

NP Devices and Printers

« v A Fa « Hardware and Sound » Devices and Printers v O Search Devices and Printers Pl

File Edit View Tools

Addadevice  Addaprinter  Seewhat'sprinting  Printserver properties  Removedevice [ + (@
~
DP-QWA10 Fax

DP-QW410  Model: DP-QW410

> Category: Printer
Status:

0 document(s) in queue

Figure 1.4.3 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

11
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In Windows 7:
In “Devices and Printers”, under Unspecified, right click on “Photo Printer”. From the menu, click

“Troubleshoot”.
=1 Eol| =
Ovl@ <« Hardware and Sound » Devices and Printers - |<‘,| | Search Devices and Printers 2 ‘
Add adevice Add a printer = - @

4+ Unspecified (1) i

— Create shortcut
©
Troubleshoot
Properties

Photo Printer | ™

— Photo Printer  Model: Photo Printer
[ Category: Unknown

Figure 1.4.4 Photo Printer under Unspecified

m

The “Install a driver for this device” screen appears. Click “Apply this fix”.
The computer searches for a driver automatically, and then installs it.

()
@ [2# Devices and Printers
Install a driver for this device
The driver for Dai Nippen Printing DP-QW410 is not installed. Install the latest driver for the
device.
[‘) Apply this fix ]
= Skip this fix
Continue troubleshooting without applying this fix.

Figure 1.4.5 Applying a fix

12
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If the driver is installed, the message “Troubleshooting has completed” appears. Click “Close the
troubleshooter” to close the troubleshooting window.

'\.:j [1# Devices and Printers
Troubleshooting has completed
to do before.

Problems found
Dai Nippon Printing DP-QW410 doesn't have a driver Fixed

The treubleshooter made some changes to your system. Try attempting the task you were trying

@

(-) Close the troubleshooter

= Explore additional options

View detailed information

Close

Figure 1.4.6 Completing troubleshooting

In Devices and Printers, make sure that “DP-QW410” is present.
This completes installation of the printer driver.

~ DP-QW410
DP-QW410 State: @ Default Status: 0 decument(s) in queue
{ Model: DP-QW410
g’ Category: Printer

=5 =R =
! \ Ll
@Uv|£§3 <« Hardware and Sound » Devices and Printers - | 3 | | Search Devices and Printers 0 |
Add a device  Add a printer  See what's printing  Print server properties  Remove device = - @

-

Figure 1.4.7 Devices and Printers screen

After the installation of the printer driver is complete, always restart the computer.

13
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Chapter 2 Properties

You can configure various printer settings from the Properties of the driver. Make sure you
understand the contents well before changing settings. To use the properties, log in as an

administrator. Depending on the application you are using, you must perform this operation from the
print settings of the application.

2.1 Open the printer properties

1. Click “Start”, and then “Windows System”--> “Control Panel” --> start Control Panel
In Windows 7, click “Start” --> “Control Panel” --> start Control Panel

B Windows Media Codec Pack

E" Windows Media Player

B Windows Powershell
B Windows System
= Command Prompt
Control Panel
P File Explorer

B Run

#8  Task Manager

= ThispC

2. From the Control Panel, click “View devices and printers” to open the Devices and Printers

EE Control Panel

— [m]
« v A » Control Panel » +| @ | search Control Panel »
File Edit View Tools
Adjust your computer’s settings View by: Category
System and Security User Accounts
Review your computer’s ststus © Change sccount type
Save backup copies of your files with ?
File History

Appearance and

Backup and Restore (Windows 7) Personalization

\' ! Network and Internet
View network status and tasks

-

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

Hardware and Sound
View devices and printers
G ER T

® e &

Adjust commonly used mebility
settings

Programs

[.1, Uninstall a program
Get programs

14
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3. Right click “DP-QW410” icon. From the menu, click “Printer Properties” to open the Properties
dialog box.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the DP-
QW410 icon is not displayed.

&f Devices and Printers

« v A P& <« Hardware and Sound » Devices and Printers v O Search Devices and Printers o
File Edit View Tools

Add a device Add a printer See what's printing Print server properties Remove device = - 0

@ See what's printing
E Set as default printer

Printing preferences

am

DP-QWA10 Printer properties

Create shortcut

) Remove device
Troubleshoot

Properties

DP-QW410  Model DP-QW410

> Category: Printer

Status: 0 document(s) in queue

4. The DP-QW410 Properties screen appears.

/= DP-QW410 Properties

Genersl Sharine Ports  Adwanced Oolor Management  Security

=

[pp-qwaig) |

Location: | |

Comment:

Madel: DP-QW410
Features
Color: Yes Paper available:
Double-sided: No (4x6)
Staple: Ne

Speed: Unknown

Maximum resolution: 300 dpi

Preferences... Print Test Page
Omcel sorly

15
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2.2 Print settings functions

If you select the basic settings from the Properties screen, you can change various print settings.

2.2.1 Layout

/= DP-QWA10 Printing Preferences

Leyout  Poper/Gusity Option  Dolor Afustment Printer Info

o
©
H
3
l

Adyanced...

Figure 2.2.1 Layout tab

Orientation

Set the print orientation to “Portrait” or “Landscape”.
For details, refer to “2.6 Orientation”.

Page Order

In the application, specify the order when multiple copies of an image are printed.

Example) Print order

No.1 No.2 No.3

Front to Back

Back to Front

Page Format

Pages per Sheet
Set printing of the specified division size. In most situations, set “1”.

Example) Division size 1 division 4 divisions 9 division

16
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If you select “Advanced...” on the Layout tab, you can configure various advanced options.

fmt DP-QWA10 Printing Preferences

Layout Paper/Quality Option  Color Adustment  Printer Info

Orientation:
-
Page Order:

Page Format

Pages per Sheet

Draw Borders

Snce ool

Figure 2.2.2.1 Advanced settings

Paper/Output

Paper Size

DP-QW410 Advanced Options

@ DP-QWA10 Advanced Document Settings
2| Paper/Output

Copy Count: 1 Copy

-] Graphic

i 24 Image Color Management

ICM Method: |CM Handled by Host System

! ICM Intent: Bictures
£-fiE Document Options
: Advanced Printing Features: Enabled
------- Pages per Sheet Layout: Right then Down
=] ﬁ] Printer Features
--------- Border: Disable
......... Overcoat Finish: Glossy
Print Re-try: Enable
2inch cut: Disable
High quality mode: Disable
--------- Decurling action: Auto

Cancel
Figure 2.2.2.2 Advanced options tab

Specify the paper size. The paper size that can be specified depends on the media size that is
loaded in the printer. If the printer is offline, the loaded media size is assumed to be 4x6.

Loadz;ﬂzénedla Specifiable paper size Multiple layout
4x3 Enable
4X6(*1)
4x4, 4x4.5, [4x6] Disable
4x3, 4.5x3 Enable
4.5x6¢1) (-2) )
4x4, 4x4.5, 4x6, 4.5x4, 4.5x4.5, [4.5x6] Disable
4x3, 4.5x3, 4.5x4 Enable
4.5x82)
4x4, 4x4.5, 4x6, 4.5x4.5, 4.5x6, [4.5x8] Disable

The paper size in square brackets [ ] is the default paper size for the loaded media.

*1: Paper sizes that cannot be used for
printing are grayed out.

DP-CW410 Advanced Options

*2: For paper sizes that can create
margins on the sides of the output results,
a warning appears.

= DP-QWA10 Advanced Document Settings
4, Paper/Output

dled by Host System

B@ Docum

: - Advanced P| (4x4)

Pages per 5 (4x4.5)
=t % Printer Featik)

Figure 2.2.2.3 Incompatibility media size
(Gray out indication)

=: Enabled
ght then Down
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= DP-OW410 Advanced Document Settings
54 Paper/Qutput

(4:6) v
Copy Count (4.5x3)

=-u] Graphic (4.5¢4)

B@ Image Colo (4.5x4.5)

(4.5%6) d by Host System
ICM Int ENE)

B@ Document Opti & (4x3)

Advanced P & (4xd) nabled
Pages per Sl & (4x4.5) then Down
=- g% Printer Featr & (4x6)

Figure 2.2.2.4 Incompatibility media size
(Warning indication)
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Copy Count
You can specify the number of copies to be published for images.

Graphic

ICM Method

ICM Method Function

ICM Disabled Synchronized with “Color Adjustment Disabled” in the 2.2.4
Option.

ICM Handled by Host System Synchronized with “Color Adjustment ICM” in the 2.2.4
Option.
Manage colors using the driver.

ICM Handled by Printer When this item has been selected, operation is the same as
“ICM Handled by Host System”.

ICM Intent

Set the rendering method when using ICM. For the ICC profile, always set to “Pictures”.
Do not use other settings.

Document Options

Advanced Printing Features
Always set “Enabled”. Do not use other settings.

Pages per Sheet Layout
Set the layout direction of an image when the Pages per Sheet setting is set for multiple divisions.

Printer Features

Border
Synchronized with Border in the Option.

Overcoat Finish
Set the overcoat finish method for the surface of printed items from the following two types.

Overcoat Finish Function
Glossy Create an item with a glossy finish.
Matte Create an item with a matte finish.

18
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Print Re-try
Specify whether to print data in the printer buffer after a printer error has been cleared.
Print Re-try Function
Disable Clear the print data in the printer buffer when a printer error occurs.

You must send the cleared print data again after the error is cleared.
When you use an application with an error recovery function, select

this option.

Enable

Save print data in the printer buffer when an error occurs.
The printing process is restarted from the saved data after the error is

cleared.

Note that if the power is switched off, the data is not saved.

Depending on the printer error, print data in the print buffer will be cleared, regardless of the Print

Re-try setting.

The following section shows the operation for each Print Re-try setting by error.

Error content

When Print Re-try is disabled

When Print Re-try is enabled

Paper end

Ribbon end

Top Door open

No trash box

You must send the unprinted
image data again after the error
is cleared.

The printing process is restarted
from the data saved in the printer
buffer after the error is cleared.
When the paper initialization
operation is to be carried out,
printing occurs afterwards.

Paper jam

Ribbon error

Paper size setting error

To prevent the occurrence of an error, printing will not be restarted,
regardless of the Print Re-try function setting.

After the printer stops due to an error, follow the User Guide of the
printer to eliminate the cause of the paper or ribbon error.

You must send the unprinted image data again after the error is

cleared.

System error

-Data error

-Head voltage error
-Head position error
-Cutter error

-Head temperature error
-Media temperature error

-RFID module error

-USB power supply
voltage error

Because the printer must be switched on and off to clear the error, the
print data in the printer buffer is cleared regardless of the Print Re-try

setting.

After the printer has restarted, you must send the unprinted image

data again.
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2inch cut
Specify whether to cut paper into multiple sheets with a 2-inch length when you use a specified
paper size.
2inch cut Function
Disable Cut at the normal size.
Enable Cut at 2-inch lengths so that the 4x4 size becomes two sheets

the 4x6, 4.5x6 size becomes three sheets and the 4.5x8 size becomes
four sheets.

In the case of 2inch cut, due to mechanical limitations, its edges can
cause slight image bleed.

It can be prevented by making the space between the images a single
color of about 3 mm as shown in the figure.

. EEEEEEE——— x 3om & e - .
I — Smm b -
Cut when paper Cut when paper
is ejected is ejected

T _ & P t_. _________________ &
I N ' aom A b '

2inch cut edges can cause

slight image bleed.
High quality mode

Enables or disables high quality mode.

High quality mode Function
Disable Prints with normal quality.
Enable Prints with high quality. -1
*1: Printing time takes longer than printing with normal quality.

Decurling action

Set the decurling action.

Decurling action Function
Disable Does not execute the decurling action.
Enable The decurling action is performed.
Auto The printer automatically controls the decurling action depending on
the media status.

Be careful as paper may get caught under the lower part of the front surface of the printer when the
decurling action is disable.
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< Multiple layout >
You can enable multiple layout settings by setting the paper size of the printer driver. If it sends
multiple images from the application, the printer driver allocate them automatically as the multiple

layout.

The following section shows the image sizes.

Layout settings

Driver paper size setting dﬁ:&?(;n FEfREl SIZe(:ﬁnm%th XAl Media used
(4x3) Portrait (107.2 x 79.3) 4x6, 4.5x6, 4.5x8
Landscape (79.3x107.2)
Portrait (119.3 x79.3) 4.5x6, 4.5x8
(4.5x3) Landscape (79.3 x 119.3)
Portrait (119.3 x 104.7) 4.5x8
(4.5x4) Landscape (104.7 x 119.3)

Note)

Because they are carried out by the print job, multiple layout are carried out when there
are multiple images in a single job.

If you want to layout the same image, send the same number of images as the number-
of-sheets setting.

The printer handles two pictures at one time and cuts the paper after it is ejected.

In the case of Multiple layout,due to mechanical limitations, its edges can cause slight
image bleed.

It can be prevented by making the space between the images a single color of about 3
mm as shown in the figure, or by printing with borders.

Cut when

paper is ejected

Multiple layout cut edges can
cause slight image bleed.

<When the top and bottom are made
into a single color of about 3mm>

Cut when

paper is ejected

Multiple layout

3mm¢_
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< Application usage example >
This usage example uses Windows Explorer.

Step 1. In Windows Explorer, select two or more pictures.

Next, click “Print”.

Camera Roll

Manage

Home Share View Picture Tools

v o <« Pictures > Camera Roll v B S Search Camera Roll

Open

Create @ new video

Edit with Photos

! Edit with Paint 3D
01_Zebra Tiger

\_/

Select 2 or more images

Set as desktop background
Edit
Print

Rotate right

Bntat

Device >

- h Microsoft Defender...

ditems 2 items selected 5.33 ME‘ 2 Share

=[]

Step 2. Select “Fit picture to frame” check box,
and then click “Options...”.

X
=
How do you want to print your pictures?
Printer: Paper size: Quality: Paper type: ®
DP-QW410 v |@a3) ~ | |300x 300dpi | | Plain Paper v

Full page photo

10f 2 pages »)

Fit picture to frame

Copiesof eachpicture: [1 ]3]

Cancel

lbgi.onsﬁ '

Step 3. Click “Printer Properties...”.

Print Settings

Sharpen for printing

Only show options that are compatible with my printer

Certain combinations of paper type, paper size, and print quality may
not print well or be available with all printers. Limiting your options to
only those that are compatible will give you the best results.

Color Management...

Printer Properties...

Cancel
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Step 4. Set the Orientation to “Portrait”,
and click “Advanced...”.

0 Printing Preferences

Layout Peper/Quslity Option Tolor Adustment Printer Info

Qrientation:
~|)
Page Order:
Front to Back ~

Page Format

Pages per Sheet

Draw Borders

Gancel

[ ok ] Apply

Step 5. Set the paper size to the setting of the
multiple layout. Click “OK” twice to close
the dialog boxes in Step 5 and 4 and
return to the display in Step 2.

DP-0W

dvanced Options

= DP-QW410 Advanced Document Settings
£-44] Paper/Output

H Copy Counf
B@ Graphic
E-@ Image Celol
1M Med

dled by Host System

i ICM Intg

& i@ Document Opti <+—
Advanced P (4x4) c: Enabled
Pages per 5f (4x4.5) ight then Down

E% Printer Featy (4<6)
Border: Disable

Overcoat Finish: Glossy
Print Re-try: Enable

2inch cut: Disable

High quality mode: Disable
Decurling action: Auto

Cancel

Step 6. Click the “Print” button.

How do you want to print your pictures?
Printer: Paper size: Quality: Paper type: ®
DP-QW410 V| | @a3) | 300x 300dpi ~ | Plain Paper R
Full page photo
1 of 2 pages »
Copies of each picture: [ 1|2 Fit picture to frame Ofions.i
2]

10)
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2.2.3 Paper/Quality

#mt DP-QWA10 Printing Preferences

Layout  Paper/Guslity Option  Color Adiustment  Printer Info

O Black & White ®/Colod

Coler

Advanced...

Ganeel fooir

Figure 2.2.3 Paper/Quality tab

Color
Set Color. Do not use black and white.

2.2.4 Option

QW410 Printing Preferences

Layout Paper/Guality OPoN  Color Adustment Printer Info Layout Paperfuslity OPtion  Golor Adustment  Printer Info

Oferder OBorder

© Nene(ly) O Handled by Driver()) O Nonelt) ‘um

@ICMD O ICM & Driver(M) @ ICMO

Language(l) English -~ Language(l)

About(B). About(B)...
Default(D) Default(D)
Sncel sarly omeal D
Figure 2.2.4.1 Option tab Figure 2.2.4.2 Sharpness setting

Border
Specify a border for printing. (Select the check box for a border.) Synchronized with Border
Enable/Disable in the Advanced settings.

Sharpness
Process sharpness using one of the 11 stages (Figure 2.2.4.2). If the setting is “O (Default)”,
sharpness is not processed. Moving to the minus (-) side blurs the image and moving to the plus
(+) side sharpens the image.
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Color Adjustment

None
Synchronized with the ICM Method in the Advanced settings. If this check box is selected,
ICM is disabled, the Color adjustment tab is also disabled, and the printer driver does not
carry out color adjustment.

Handled by Driver
If this check box is selected, ICM is disabled, and the 2.2.5 Color Adjustment is enabled.
The result is applied to the adjustment values of the following items: Gamma, Brightness,
Contrast, and Chroma.

ICM
Synchronized with the ICM Method of the Advanced settings (ICM Handled by Host System).
If this check box is selected, the driver manages colors.

ICM & Driver
If this check box is selected, ICM (color management) and the 2.2.5 Color Adjustment are
enabled.

Language
Change the display language for the following items: “Option”, “Color Adjustment”, and “Printer
Info”. The selected language is enabled the next time the print settings are displayed.

[Available languages]
- Japanese
- English (US)
- French (France)
- German (Germany)
*+ Russian (Russia)
+ Spanish (Spain)
- Korean
+ Chinese (People's Republic of China)
+ Chinese (Taiwan)

+ When your operating system environment corresponds with one of the above settings, the default
display language is the language of the corresponding country. Furthermore, when your
operating system environment does not correspond with one of the above settings, the default
display language is English.

- To use a language different from that of your operating system, you must install the following font
for the corresponding language.

Language Font
Japanese Meiryo / Yu Gothic Ul <Windows10>
English (US) Segoe Ul
French (France) Segoe Ul
German (Germany) Segoe Ul
Russian (Russia) Segoe Ul
Spanish (Spain) Segoe Ul
Korean Malgun Gothic
Chinese (People's Republic of China) Microsoft YaHei
Chinese (Taiwan) Microsoft JhengHei

About
Show the driver version.

24



2.2.5 Color Adjustment

[DP-QW410 Printer Driver] Instruction Manual (For Windows 7 and 10)

If the Handled by Driver check box is selected in the 2.2.4 Option, the adjustment values of the

Color Adjustment tab are applied to the image.

#mt DP-QWA10 Printing Preferences

Layout  Paper/Qualty Option Color Adustment  Printer Info

Sample Picture

Gamm: Brightness Contrast

L SO L ol OO = IS Sl OO

G 0 G: 0o = G

B B: 0 = B

=E b =Y

Chrom:

] ]
Default(D)
Load(L)...
Save(S)...
Cancel Aosly

Figure 2.2.5 Color Adjustment tab

The following section shows the setting ranges on the Color Adjustment tab.

Adjustment item Adjustment value

Gamma -100 (dark) to 100 (bright) (“0” results in no adjustment, y2.0 to 0.5)

brightens the half-tone section.
Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Adjust the density of the half-tone section of the image. Increasing the gamma value

Brightness -100 (dark) to 100 (bright) (“0” results in no adjustment)

entire image.

Sync check box
ON: Set RGB to same value.
OFF: Set RGB to different value.

Adjust the brightness of the image. Increasing the brightness value brightens the

Contrast -100 (weak) to 100 (strong) (“0” results in no adjustment)

difference of brightness and darkness.
Sync check box

ON: Set RGB to same value.

OFF: Set RGB to different value.

Adjust the contrast of the image. Increasing the contrast value increases the

Chroma -100 (weak) to 100 (strong) (“0” results in no adjustment)
Adjust the chroma of the image.
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2.2.6 Printer information

View the printer information.

/mt DP-QWA10 Printing Preferences

/= DP-QWA10 Printing Preferences.

Layout  Paper/Qualty Option  Color Adustment  Printer Info. Layout Paper/Qualty Option  Color Adustment = Printer Info
Media Info [ Premium Digital Media Info [ Premium Digital 1
150 4 150 Shests -/ - Sheets
0% 0% 100% 0% 50% 100%
Printer Status Printer Status
‘ Waiting ‘ ‘ Waiting
= = << Incorrect media type has been loaded. 5>
— o
Total Count Firmuare Version Total Count Firmware Version
2901 QWA1000.37 201 QWA100037
Serial No. Serial No.
QWAC- 00150 QWAC-001500¢
Color Control Data Color Control Data
Version Checksum Version Checksum
200dpi QWA10_SD_300_0031.CWD 4925 300dpi QWA10_SD_300_0031. CWD 2025
Low Speed QW10_SD_310_0031.CWD 9708 Low Speed QWA10_SD_310_0031.CWD ot
Update(U) Update(U)
Cancel 2oy Cencel soply

Figure 2.2.6.1 Printer Information tab Figure 2.2.6.2 Display when

incorrect media is loaded

The following section shows the information displayed in the Printer Info tab.

Display item Display details

Media Info This area shows, for example, the class, the size, and the remaining number
of printable sheets for the ribbon media in the printer.
* Media information is not displayed when a media type not supported by the
printer has been loaded. (Figure 2.2.6.2)
Displays the status of the printer using icons and characters.

Printer Status

Display icon  Display Status/Response
(Color) characters
@ Waiting Printing is possible.
(Green)
g Printing The printer is printing.
(Blue)
Top door open Top door is open.
Close the top door.
(Yellow)
Ribbon end No ribbon remains.
Load new media.
% (Replace the paper and ribbon as a set.)
(Yellow)
Paper end No paper remains.
Load new media.
(Replace the paper and ribbon as a set.)
~3
(Yellow)
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Display details

Printer Status

Display icon  Display Status/Response
(Color) characters
Offline The printer cannot be recognized.
Connect the printer and computer, and then
turn on the power.
(Gray)
= Cooling head The head is being cooled.
A Please wait a while.  Printing will resume
= automatically.
el
(Purple)
. Ribbon error The ribbon is not set correctly.
N Reload the ribbon properly.
.._%
(Orange)
. Paper size The printer settings and size of the installed
— setting error ribbon do not match.
Check the paper size setting and ribbon size.
—[3
(Orange)
P Paper jam A paper jam was detected.
Y Remove the paper and reload it properly.
—
(Orange)
— No trash box The trash box is being detached.
N Attach the trash box.
—
(Orange)
System error System error.
Restart the printer and computer. If the
printer does not recover after the restart,
— contact the service center.
(Red)

* A warning message is displayed when a media type not supported by the
printer has been loaded.(Figure 2.2.6.2)

Total Count

Total count of printed sheets.

Firmware Version

Version of the control program of the printer. xx.xx indicates the version.
+ QW410 xx.xx

Serial No. Serial number of the printer.
Color Control Printer color control data.
Data
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2.3 Default values for settings

The following section shows the default values of the settings (at installation).

If the settings have

been changed, and the printer driver no longer operates normally, return to the default values shown

below.

Note) Depending on the service pack of your operating system or your usage environment, the

default values at installation may differ from those in the chart below.

Chart 2.3 Default print settings

Tab Setting Value
Orientation Portrait
Layout Page Order Front to Back
Pages Per Sheet 1
Paper/Quality Color Color
Border Disable
. Sharpness 0 (Default
Option CoIofAdjustment : ICM !
Language setting English
Gamma 0
Color Brightness 0
Adjustment Contrast 0
Chroma 0
. Depends on printer
Paper/Output Paper Size rr?edia Sizep(*1)
Copy Count 1 Copy
ICM Handled by Host
Graphic LTaangaegg;Ié);t ICM Method S.ystem
Advanced ICM Intent Pictures
settings Advanced Printing Features Enabled
(In the Layout Pages per Sheet Layout Right then Down
tab, click Border Disable
“Advanced...”) —
Document Overcoat Finish Glossy
options . . Print Re-try Enable
Printer function - Ioinch cut Disable
High quality mode Disable
Decurling Action Auto

*1: For the initial values of paper sizes, see “2.2.2 Advanced options”.
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2.4 Color management

Use Color management to specify the color profile. The installer associates “SD QW4 10-xxxx.icc”
and “PD_QW410-xxxx.icc” by default.

This printer driver automatically changes the printer color profile in accordance with the media that is
loaded in the printer.

To use an ICC profile other than the default profile, overwrite the ICC profile that has been registered
as the default.

For the ICC profile to overwrite, prefix “SD_" to the profile name for Digital media and prefix “PD_" to
the profile name for Premium Digital media.

Example: Overwritten profile name
For Digital 1 SD_XXXXXXXX.icC

For Premium Digital : PD_xxxxxxxx.icc

Step 1. From the Printer Properties, Step 2. From Device, select DP-QW410.
select the Color Management tab, and
then click “Color Management...”.

{5 DP-QWA10 Properties

Genersl Sharine Ports Advinced Dolor Manseement  Security Devices AllProfiles  Advanced

Device: | Printer: DP-QW410 v)
[ Use my settings for this device Identify menitors

Profile selection: Automatic (Recommended)
Profiles associated with this device

Name File name

ICC Profiles

SD_QWA10) SD_QWA1D i

PD_QWAID, PD_QWAT0 "Il

cc
cc
ICC Profiles (Advanced Color)
SD_QW410.| 0. icc
PD_QW410_ 4

The installer associated this file

efault Profile

Figure 2.4.1 Color Management Tab Figure 2.4.2 Color Management Window
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2.5 Print Area

The following section shows the image sizes and numbers of dots generated by the paper size setting

of the driver.

B Image size Number of image dots
rin
Paper size L (width x height) (width x height)
direction } i
(inch) (mm) 300x300dpi
(4x3) Portrait 47x 3" 107.2x79.3 1266 x 936
X
Landscape 3’x 47 79.3 x107.2 936 x 1266
(4xd) Portrait 4°x 47 107.2 x 104.7 1266 x 1236
X
Landscape 4°x 47 104.7 x 107.2 1236 x 1266
Portrait 4x 4.5” 107.2x 117.4 1266 x 1386
(4x4.5)
Landscape 4.5'x 4” 117.4 x 107.2 1386 x 1266
(4x6) Portrait 4°x 6” 107.2x 155.5 1266 x 1836
X
Landscape 6"x 4” 155.5x 107.2 1836 x 1266
Portrait 45x 3" 119.3x79.3 1408 x 936
(4.5x3)
Landscape 3’x 4.5 79.3 x119.3 936 x 1408
Portrait 4.5x 4” 119.3 x 104.7 1408 x 1236
(4.5x4)
Landscape 4’x 4.5” 104.7 x 119.3 1236 x 1408
Portrait 4.5"'x 4.5” 119.3x 117.4 1408 x 1386
(4.5x4.5)
Landscape 4.5"x 4.5” 117.4 x 119.3 1386 x 1408
Portrait 4.5"x 6” 119.3 x 155.5 1408 x 1836
(4.5x6)
Landscape 6"x4.5" 155.5x 119.3 1836 x 1408
(4.5x) Portrait 45" x 8 119.3 x 206.3 1408 x 2436
.5x
Landscape 8" x4.5" 206.3 x 119.3 2436 x 1408
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2.6 Orientation

The following chart shows the relationship of images generated by an application and printed items
(output direction) according to the orientation setting. Generated images are not the original image
rotated by the application but are zoomed to fit within the sizes is shown in “2.5 Print Area”.

Driver setting
Paper setting
Original 4x3). (4.5x3). (4.5x4 (4X4): (4X4'5)! (4X6)1
image Orientation ( ), ( ), ( ) (45X45), (45X6), (45X8)
Generated Printed item Generated Printed item
image (Output orientation |) image (Output orientation |)
Portrait
Landscape
Portrait
Landscape
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Chapter 3 Update the driver

As when performing the installation, log in as an administrator before carrying out this operation.
1. Check the job

1) Before updating the printer driver, close all applications. Furthermore, click on the icon of the
printer to be updated in the Devices and Printers screen. At the bottom area of the screen,
confirm that there are no documents in the queue, and then start update of the driver.

Note: In Windows 10, when the printer is offline (the printer is not on and connected), the DP-
QW410 icon is not displayed. Always connect the printer with the power turned on and
check that there are no documents in the queue.

"t Devices and Printers

« © /4~ Fa <« Hardwareand Sound » Devices and Printers N Search Devices and Printers pel

Fle Edit View Tools

Add a device Add a printer See what's printing Print server properties Remove device = - o

DP-QW410 Fax

DP-QW410  Model: DP-QW410

» Category: Printer
Status: 0 document(s) in queue

Figure 3.1 Clicking the DP-QW410 icon at the Devices and Printers screen
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2. Uninstall the driver package

1)Click “Start”, and then click “Windows System” -> “Control Panel”.

“Uninstall a program”.

In Windows 7, click “Start”, and then click “Control Panel”.

program”.

B Windows Media Codec Pack

E" Windows Media Player

B Windows Powershell
B Windows System
= Command Prompt
BE Control Panel

P File Explorer

=

Run
#8  Tosk Manager

This PC

-
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E& Control Panel

€« v P s Control Panel »

Eile Edit Yiew Tools

Adjust your computer's settings

System and Security

Review your computer's status

Save backup copies of your files with
File Histary

Backup and Restore (Windows 7)

L ¢}

ol Network and Internet
View network status and tasks
./ Hardware and Sound
View devices and printers
Add a device
Adjust commonly used mobility
settings

Programs

Get pregrams

Q&L

8]

In the Control Panel, click

In the Control Panel, click “Uninstall a

[m]

v O

Search Control Panel

View by: Category ~

User Accounts
M) Change account type

Appearance and
Personalization

Clock and Region
Change date, time, or number formats
Ease of Access

Let Windows suggest settings
Optimize visual display

2) The “Uninstall or change a program” screen appears.

PrintingDP-QW410”.

8] Programs and Features

Figure 3.2 Control Panel

In the list, double click “Dai Nippon

«
Eile Edit View Tools

Control Panel Home

View installed updates

) Tum Windows features on
off

Install a program from the
network

“ 4 [ « Programs > Programs and Features

v O

Uninstall or change a program

To uninstall a program, select it from the list and then click Uninstall, Change, or

or Repair.

Organize ~ Uninstall Change  Repair

Search Pragrams and Features

e

o
i

‘ 8 Dai Nippon Printing DP-QW410

-/ ©

Dai Nippon Printing Product versien: 0.2.0.0

Help link:  http://www.dnp.co.jp/

Figure 3.3 Uninstall a program
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3) Click “Yes” when the Dai Nippon Printing DP-QW410 uninstall confirmation windows appears.
Uninstalling the driver is complete. After uninstalling the printer package, restart the computer.

Programs and Features

I Are you sure you want to uninstall Dai Nippon Printing DP-CW4107

[ Inthefuture, do not show me this dialeg box Yes

Figure 3.4 Uninstallation confirmation

When a User Account Control dialog box appears, click “Yes”.

User Account Control X
Do you want to allow this app from an
unknown publisher to make changes to your
device?

e e e R

Publisher: Unknown
File origin: Hard drive on this computer

Show more details
[ Yes ] No |

Figure 3.5 User Account Control

3. Install an upgrade for the printer driver

After deleting the printer and the printer driver, install the new printer driver.  For the installation
procedure, see “Chapter 1 Installation”.

4. Restart the computer

After the installation of the printer driver is complete, always restart the computer.
(Do not print just after installation. Always restart the computer once.)
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Chapter 4 Delete the driver
4.1 Automatic deletion of printer drivers

The printer driver is automatically deleted when uninstalling the driver package.
For the steps to uninstall the driver package, see “2. Uninstall the driver package” in Chapter 3.

Note that uninstalling the driver package when the printer driver is in use will display the following
message, and the printer driver will not be deleted.

DP-OW410 Printer Driver Uninstaller

:l The specified printer driver is currently in use.

Figure 4.1 Message displayed when the driver is in use

When the above message is displayed, restart the computer and then delete the printer driver using
the procedure described in “4.2 Manual deletion of printer drivers”.
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4.2 Manual deletion of printer drivers

1)Click “Start”, and then click “Windows System” -> “Control Panel”. In the Control Panel, click
“View devices and printers”.

In Windows 7, Click “Start”, and then click “Control Panel”. In the Control Panel, click “View
devices and printers”.

From the “Devices and Printers” screen, right click the DP-QW410 printer. From the menu, click
“Remove device”.

B Devices and Printers

“ v 4 Fa « Hardware and Sound » Devices and Printers v @ Search Devices and Printers yel

File Edit View Tools
Add a device Add a printer See what's printing Print server properties Removedevice & = o

A

% See what's printing
t Set as default printer
Printing preferences

DP-QWA10 Printer properties

Create shortcut

(G Remove device )

Troubleshoot

Properties

DP-QW410  Model: DP-QW410

» Category:  Printer

Status: 0 decument(s) in queue

Figure 4.2.1 Right clicking DP-QW410 in the Devices and Printers screen
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In Windows 10, when the printer is offline (the printer is not on and connected), the DP-QW410
icon is not displayed. In such cases, use the following procedure to delete the device.

(i) On an empty area in the Devices and Printers screen, right click, and then select “Device
Manager”.

View >
Sort by >
Group by >
Refresh

Paste

Paste shortcut

Add devices and printers

Device Manager
L 9

Figure 4.2.2.i Right clicking on an empty area in the Devices and Printers screen

(ii) Click “View”, and then select “Show hidden devices”.

o Device Manager
File Action \View Help

da e | F| 8 Devices by type

Devices by connection
Devices by contsiner
Resources by type
Resources by connection

~  Show hidden devices

Customize...

Figure 4.2.2.ii Displaying the View menu for hidden devices

(iii) Under “Printers”, right click “DP-QW410”, and then select “Uninstall device”.

& Device Manager

File Action View Help

e DE H=2 kX

~ [ Printers
=1 DP-QW410
B Security device mmpaate driver
[3 Sensors Uninstall device )

1] Sound, vid£o o
Gai Storage contro

= Storage volum Properties
B Coctorn davicac

Figure 4.2.2.iii Displaying the menu to delete DP-QW410

(iv) At the “Uninstall Device” screen, click “Uninstall”.

Uninstall Device

DP-QWH 0
=
==

Warning: vou are about to uninstall this device from your system.

[ Eeiete he driver sofiare i his devied;

' Uninstall ' Cancel

Figure 4.2.2.iv Uninstall Device screen
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2) The printer deletion confirmation dialog box appears. Click “Yes”.

Remove Device

== Areyou sure you want to remove this device?

DP-QW410

Yes

Figure 4.2.3 Printer deletion confirmation dialog box

3) After deleting the DP-QW410 printer, select another printer (for example, Fax), and then click
“Print Server Properties” in the menu bar.

A Devices and Printers

<« ~  [Fe « Hardware and Sound » Devices and Printers w D Search Devices and Printers el

File Edit View Tools

Add a device Add a printer Seewhat's printing Print server properties Remove device = - o

-

Fax  Model: Microsoft Shared Fax Driver
@ Category: Fax
Status: 0 document(s) in queue

Figure 4.2.4 Displaying the Print Server Properties menu in the Devices and Printers screen
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4) The “Print Server Properties” dialog box appears. Click the “Drivers” tab. From the installed
printer driver list, select “DP-QW410”, and then click “Remove...”.

% Print Server Properties

Foms  Ports ecuriry Advanced

Installed printer drivers:

Name Processor

A e

Cancel Apply
Figure 4.2.5 Printer Server Properties dialog box

5) The Remove Driver and Package dialog box appears. Select “Remove driver only”, and then
click “OK”.

Remaove Driver And Package

Do you want to remove the driver(s) only, or remaove
the driver(s) and driver package(s) from your system?

)

(@

(O Rernove driver and driver package.

Figure 4.2.6 Remove Driver And Package dialog box
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6) The Print Server Properties confirmation dialog box appears. Click “Yes”.

Print Server Properties

|\ Deleting this printer driver will remove it
from the system. Are you sure you want
to delete DP-QW410?

] Yes No

Figure 4.2.7 Driver deletion confirmation dialog box

If the following message appears, the operating system may be using the driver (Print Spooler
service) in the background. Disconnect the USB cable and then restart your computer and try
deleting the printer driver again.

Print Server Properties

Unable to remove DP-QW410, x64, Type
3 - User Mode driver.

The specified printer driver is currently in
use.

Fig4.2.7.i Driverin use

7) In the Print Server Properties dialog box, confirm that DP-QW410 was deleted, and then click
“Close”.

!;! Print Server Properties

Forms Ports  Drivers  Security  Aduwsnoed

Installed printer drivers:

Mame Processor Type 0

Add... Remove.. Properties

(el Apply
Figure 4.2.8 Print Server Properties
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